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1. SPECIFICATION

GENERAL SPECIFICATIONS

PERFORMANCE SPECIFICATIONS … … … … … … … … … ...FCC PART 90

POWER SOURCE … … … … … … … … … … … … … … … +13.6VD.C. nominal(+10.8 to +15.6V )

TEMPERATURE RANGE

STORAGE … … … … … … … … … … … … … … … .80℃ maximum -40℃ min.

25℃ nominal

OPERATING … … … … … … … … … … … … … … .60℃ maximum -20℃ min.

ANTENNA IMPEDANCE … … … … … … … … … … … … ...50Ω

FREQUENCY CONTROL … … … … … … … … … … … … … ...PLL SYNTHESISER

FREQUENCIES OF OPERATION … … … … … … … … … .136~165 , 146~174MHZ

FREQUENCY TOLERANCE AND STABILITY … … … … ±1.5PPM

MODULATION TYPE … … … … … … … … … … … … … … … .FM

INTERMEDIATE FREQUENICES … … … … … … … … … … .21.4 MHZ

455 KHZ

CHANNEL SPACING … … … … … … … … … … … … … 12.5 /25KHZ

TRANSMIT ATTACK TIME … … … … … … … … … … ＜25 mS

HIGH HUMIDITY … … … … … … … … … … … … … … … … .90﹪

CHANNEL CAPABILITY … … … … … … … … … … … … … .16 by software control

NOMINAL DIMENSIONS … … … … … … … … … … … … … .134 ㎜(L)X60 ㎜(W)X33 ㎜(H)

WEIGHT … … … … … … … … … … … … … … … … … … … … … .145g

RADIO DATA TRANSCEIVER NOMINAL PERFORMANCE

TEST FREQUENCY-------------------------------------------------142.0125MHZ

RECEIVER TEST AT 12.5KHZ CHANNEL SPACING

1. Audio Level (0.3~0.5V) ----------------------------------------245mV

2. Distortion (＜ 5%)--------------------------------------------2.3%

3. SINAD (> 12dB at –119dBm)----------------------------15dB

4. Current ---------------------------------------------------------------90mA

5. Carrier Detect Level--------------------OFF: -114dBm ON:-116dBm

TRANSMITTER TEST AT 12.5KHZ CHANNEL SPACING

1.RF Output Power(5.0~6.5W)--------------------------------------5.5W

2.Current (＜1300mA)------------------------------------------------1180mA

3.Deviation (1.7~2.1 khz at 106mV)---------------------------------1.9khz

4.Distortion (＜ 5%)---------------------------------------------------0.9%
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2. CONNECTIONS AND OPERATION

EXTERNAL CONNECTIONS

1- 50Ω BNC SOCKET

2- 9 WAY 〝 D 〞TYPE PLUG(J501)

D-TYPE INTERCONNECTIONS

PIN FUNCTION TYPE RANGE DESCRIPTION
J501-1 DATA_IN ANALOGUE 106mV EXTERNAL MODULATION INPUT
J501-2 DATA_OUT ANALOGUE 250~350mV RECEIVER AF OUTPUT
J501-3 PTT INPUT 0V/+5V TRANSMIT ENABLE
J501-4 GND GND 0V GND
J501-5 B+ V+ +13.8V POWER SUPPLY
J501-6 CDS OUTPUT OPEN/SHORT RF CARRIER DETECT
J501-7 RSSI OUTPUT 1.2V~2.3V RSSI OUTPUT
J501-8 PGM_DATA INPUT 0V/NC PROGRAMMER DATA INPUT

J501-9 PGM_ENB INPUT 0V/5V PROGRAMMING ENABLE
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3. CIRCUIT DESCRIPTION

TRANSMITTER

The transmitter is comprised of:

• Audio amplifier connections from J501 pin 1

• Frequency Synthesizer

• Transmitter

• Automatic Power Control

Audio frequency connections

Processed data from the U602 is applied to the VCO via R621

and applied to the TCXO VC

Frequency synthesizer circuit

With data received from the EEPROM (U503) the frequency synthesizer circuit controls and

Produces the RF carrier frequency for the transmitter during transmit and the local oscillator

frequency for the receiver. The frequency synthesizer circuit is comprised of:

• 12.8 MHZ Tcxo

• Voltage Controlled Oscillator (VCO) module

• Charge Pump and Loop Filter

• PLL Frequency Synthesizer

• Dual Modulus Prescaler
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PLL Synthesizer

The PLL synthesizer circuit is common to both the transmitter and receiver,

The synthesizer comprises:

Data

RF Out

12.8 MHZ TCXO

X401 is VCTCXO , which provide stable oscillator of 12.8 MHZ to PLL IC.

Frequency adjustment is provided by VR401

.Voltage controlled oscillator module(VCO)

The module produces carrier frequencies during transmit and local oscillator frequencies during receive.

The module contains RX VCO and TX VCO . TX VCO for producing carrier frequencies during

Transmit and RX VCO for producing the local oscillator frequency during receive .

The module also has Rx and TX powerline filters.

RX and TX power line filters

Transistor Q306 is configured as a 5v power supply ripple filter. The filter reduces the noise on the carrier and

local oscillator signals.
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RX VCO

The RX VCO comprises JFET Q301, coil L302 , and varactor D301 and is configured as a Colpitts Oscillator .

D301 produces a change in frequency with a change in DC voltage and is controlled by the tuning voltage signal

present at the cathode. The local oscillator signal at the source of Q301 isa pplied to the buffer/amplifier formed

by Q305 and Q201.The Local signal is applied to the mixer when diode D203 is reverse biased and D202 is

forward biased.

TX VCO

The TX VCO comprises JFET Q302,coil L305 , and varactor D302 and D303 and is configured as a Colpitts

oscillator . D302 produces a change in frequency with a change in DC voltage and is controlled by the tuning

voltage signal present at the cathode. The AF signal at J901 pin 1 is applied to the cathode of D303 to produce

FM modulation. When diode D203 is forward biased and D202 is reversed biased the modulated RF signal at the

collector of Q201 is passed to the power Amplifier and harmonic filter via the cascode buffer/amplifier Q205.

PLL IC

The reference frequency from the TCXO, at 12.8 MHZ , is connected to pin 1 of U401(MB1504) the appropriate

VCO is connected to pin 11.

REFDIV divides the 12.8 MHz to produce a reference frequency (Fr) of 5 or 6. 25 kHz dependent upon channel

spacing selected. VARDIV divides the prescaled VCO frequency to produce a variable frequency (Fv). Fv and Fr

are fed to the phase detector.

Phase detector

When Fv=Fr, the phase detector output (pins 15 and 16,U401) produces narrow negative pulses and Fv and Fr

pulse widths are identical. When Fv〉Fr pin 15 (V) pulses negative with pin 16(R) remaining high.

When Fv〈Fr pin 16 (R) pulses negative with pin 15(V) remaining high.

The signal at pin 15 and 16 is smoothed the loop filter and applied to the VCO.

Out-of-lock detector

The out-of-lock detector produces a series of logic level pulses when the loop is out of lock at pin 7 of U401.The

pulses at pin 7 of U401 are buffered by Q401 and then integrated by R407 and C406. The product of the

integrating circuit is fed to Q202 to turn off transmitter power.

Charge Pump and Loop Filter

Transistors Q402~Q404 , and associated resistors and capacitors form the charge pump and loop filter .

The phase detector output from U401 pins 15 and 16 are combined by the charge pump to produce a 0 to 8V

tuning voltage signal.

The signal is filtered by the loop filter (R414,C414 and C413) to remove any residual reference frequency

harmonics from the signal. After filtering the signal is applied to the voltage controlled oscillator module.
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DC REGULATOR

The DC Regulator U402, converts the +13.6 V to a 5V supply .

This is used to provide the tuning voltage for the VCO .

Dual modulus prescaler

The prescaler divides the VCO frequency by 64 or 65.

Transmitter

The transmitter comprises:

VCO Buffer PA Module

Amp

Buffer

When the radio is in transmit mode the diode D203 is forward biases enabling the modulated RF signal

from the VCO to pass to the buffer/pre-amplifier Q205 and associated components.

The output signal is passed from Q205 to Q206 via a matching network consisting of inductor L203 and

C217.

PA module

The signal is then amplified for transmission by 207, which is a power amplifier module.

Low pass filter

The amplified RF signal is passed through the stripline coupler and is fed to the harmonic low pass filter,

comprising L211 to L212 and C228-C240 and then to the antenna connector (ANT).

Antenna Switch

When transmitting, the diodes D205 are forward biased, allowing the RF to pass to the antenna. D206 is

shorted to ground which makes L210 look open circuit (1/4 wave tuned stub). This prevents the TX signal

from passing to the receiver stage.

Power output control .

The RF power tuning by VC201,which make sure the current less than 1300mA when output power is 5 W.
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Receiver
The receiver comprises:

SAW FILTER&

Amp

IF Amp

Data Out

PAGE8
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Antenna Switch

In receive, the diode D205 are reverse biased. L210 is now in circuit, passing the signal from the antenna to

the front-end amplifier Q101.

Front End

The receiver signal is passes through the band pass filter consisting of C101 to C109/L101 to L104.

Diode D101 serves as protection from RF overload from nearby transmitters.

The input signal is coupled to the base of Q101 which serves as an RF amplifier.

The output of Q101 is then coupled to a second bandpass filter consisting of C114 to C119 / L105 to L107.

The output of the front end signal then coupled to the dual-gate FET mixer Q102.

First Mixer

Q102, 2-pole crystal filters XF101 and coils T101 and C123 form the First Mixer and First IF Filter.

The RF signal, from the front-end filter and amplifier Q101 is applied to the VCO local oscillator signal to

make mixer.

The difference frequency of 21.4 MHz is taken from Q102 and is filtered by the crystal filters XF101.

The tuned circuits T101 and associated components provide matching of the crystal filters to ensure a good

pass-band response and selectivity.

The IF signal is amplified by Q103 and passed to the FM Detector IC.

Second mixer, Second IF, FM detector

The output of the IF amplifier is fed into the narrowband FM IF Integrated Circuit U101 (MC3361).

This is a single conversion FM receiver which contains the second mixer, second IF amplifier, and FM

detector.

Crystal X101,connected to pin 1 of U101, determines the second local oscillator frequency.

In this case the crystal has a frequency of 20.945MHz. The first IF signal is applied to the mixer and

resultant frequency of 455KHz, is the difference between the IF signal and second local oscillator.

The 455KHz IF signal is output from pin 3 and is applied to a 455KHz band-pass filter CF1.

The output of CF1is passed via pin 5 to a high gain IF amplifier coupled to the adjustable quadrature

detector CD1.Any detected signal is produced at pin 9 of U101 and applied to the Receiver Audio Circuit

and the Mute (Squelch) Circuit.

Squelch ( MUTE ) Circuit

Any noise signal is amplified by U101 int ernal noise amplifier .signal is applied to pin10 of

U101. The squelch trigger output (pin 13,U101) is applied to the pin 6 of J903.

When noise is present, the voltage at pin 12 of U101 is exceeds than 0.7V. The squelch trigger output is

open, It’s make pin 6 of J903 open state.

When no noise is present, the voltage at pin 12 of U101 less 0.7v and pin 13 of U101 is HI voltage.

This make pin 6 of J903 short state.

VR101 is set to tuning squelch when 25khz channel space is present.

Carrier Detect

A Carrier Detect ( MUTE DETECT ) output is available on pin 6 of J903 .

AF Output Low Pass Filter

A low pass filter formed by R115 and C132 removes any extraneous 455kHz energy from the AF output of

the FM receiver chip (pin 9 of U101).

PAGE9



The filtered signal is passed to pin 2 of J903.

Microcontroller

The PIC16C57C04 microcontroller IC controls the programmable features and frequency synthesizer data.

Programming Mode

The programming mode allows the user to retrieve or program TX/RX frequencies, when pin 2 of J903 is set to

ground. Programming mode will Inhibit , serial communications can then be made in order to read/program the

on- board EEPROM ( U503 )which contains radio- specific data.

EEPROM

Relevant channel information, such as Rx/ Tx frequencies, is stored in the EEPROM( U503) which is a 93C46.

This information may be programmed and erased via the D- type socket.

The EEPROM has 1024 (8x128) capacity and is written serially.

Power supply circuit

The data radio is supplied with a nominal + 13.8V dc power supply input from external

equipment which is filtered using C512. This supply is converted into 5V

voltage levels on the board using the regulator U402 and associated components .

This +5V line is fed to the CPU circuit .

4. PERFORMANCE TEST AND ALIGNMENT

The alignment and performance test procedures assume the use of the following equipment.

Discrete test equipment

Volt Meter Spectrum Analyser and notch filter(option)

RF Power Meter. Coupler (20dB isolation)

DC Power Supply, 0-15V 2A min Distortion Meter

Oscilloscope, 20 MHz dual beam

RF Frequency Counter,

100 kHz - 600 MHz

AF Signal Generator 0 – 20 kHz

RF Signal Generator

SINAD Meter

Modulation Meter

Audio Power Meter
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5. TEST EQUIPMENT CONFIGURATION.

RF Signal Generator

Watt Meter with

20dB Attenuator

Audio Generator

Modulation Meter

SINAD Meter OSCILLOSCOPE

RADIO

VOLT Meter

Spectrum Analyzer

DC Power Supply

Frequency Counter

Test Box

Test Equipment Configuration
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6. TRANSMITTER PERFORMANCE TESTS

Power Output

Transmit periods longer than 3 minutes are to be avoided.

1. Set the power supply voltage to 13.8V dc. and monitor the voltage during transmit.

2. Switch data radio TX and check and record the output power. The nominal output

power is adjustable about 5W and make sure the current less than 1300 mA..

3. Set the PTT switch to OFF .

Frequency accuracy

1. Whilst transmitting, measure the transmit frequency using the RF frequency counter.

2. Adjust VR401 so that frequency is as close as possible to the exact required transmit frequency.

Ideally it should be within 100 Hz at room temperature.

Peak Deviation

1. Connect the oscilloscope to the output of the modulation meter.

2. Set the AF signal generator to 1000 Hz at 106mV and connect to DATA _IN line ( pin 1 of J501 )

3. Switch data radio to TX and observe the oscilloscope display to check that the 1000Hz

tone is a sine wave and adjust VR601 to make deviation is about 3.5KHZ.

4. Using the AF signal generator, sweep from 100 Hz to 3 kHz and record the peak deviation.

5. Check the peak deviation for appropriate channel spacing as follows：

For 12.5 kHz channel spacing, Peak deviation is not greater than 2.5 kHz.

For 20 kHz channel spacing, Peak deviation is not greater than 4 kHz.

For 25 kHz channel spacing, Peak deviation is not greater than 5 kHz.

Spectrum Test

It may be necessary to notch the fundamental signal during this test.

1. Connect a spectrum analyser and RF power meter to the antenna socket.

2. Switch data radio to TX. Observe the output spectrum on the spectrum analyser.

3. Adjust notch filter to minimise the carrier. All spurious and harmonics signals

should be below- 36 dBm up to 1 GHz and below –30 dBm between 1 and 4 GHz.

4. Switch off the data radio transmit control.
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Receiver Performance Tests

Sensitivity

The SINAD performance test may be used to test the sensitivity of the receiver.

1. Connect the RF signal generator to the data radio BNC antenna connector.

2. Set the RF signal generator to the receive frequency .

3. Connect the leads of the SINAD meter between 0 V and pin 2 on J501.

4. Set the deviation to 60﹪of the peak system deviation.

5. Set the AF generator to 1 kHz.

6. Adjust the RF signal generator level until the SINAD Meter reads 12 dB.

7. Check that the signal generator RF level is less than 0.25uV pd (-119dBm ).

Squelch/Carrier Detect Adjustment

1. Set the RF signal generator to the receiver frequency with 60﹪deviation. Set the AF signal to 1 kHz

2. Set RF input level to give -113dBm.

3. Adjust VR101 until CDS J501 pin 6 changes state from “HIGH” to “LOW”.

4. Reduce RF input level to –115dBm and check that CDS line goes HIGH .

Switch off the RF generator and disconnect the test equipment.
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6. PARTS LIST

0803VRI2.SCH Revised: February 27, 2014

136~165MHZ/12.5KHZ Revision:

Bill Of Materials February 27, 2014 10:21:12

Item Quantity Reference Part

________________________________________________________________

1 1 C101 560P

2 6 C102,C108,C111,C112,C119, 39P

C230

3 9 C103,C109,C110,C117,C135, 100P

C418,C419,C420,C617

4 9 C104,C136,C217,C231,C233, 47P

C302,C308,C506,C608

5 9 C105,C107,C226,C236,C244, NU

C246,C303,C310,D402

6 2 C106,C336 9P

7 1 C114 150P

8 44 C115,C120,C121,C122,C126, 102P

C139,C202,C203,C206,C209,

C210,C212,C214,C216,C218,

C220,C222,C223,C225,C227,

C228,C229,C234,C235,C237,

C301,C307,C313,C314,C316,

C317,C318,C319,C325,C326,

C328,C401,C404,C415,C422,

C423,C424,C426,C511

9 2 C116,C140 56P

10 1 C118 270P
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0803VRI2.SCH Revised: February 27, 2014

136~165MHZ/12.5KHZ Revision:

Bill Of Materials February 27, 2014 10:21:12

Item Quantity Reference Part

________________________________________________________________

11 5 C123,C311,C312,C403,C408 5P

12 17 C124,C134,C137,C142,C143, 104P

C205,C324,C329,C402,C406,

C411,C421,C427,C429,C502,

C606,C618

13 1 C125 474P

14 4 C127,C129,C130,C133 220P

15 5 C128,C215,C221,C407,C412 103P

16 2 C131,C601 1U/X7R 0805

17 2 C132,C607 223P/X7R 0603

18 2 C138,C428 33U/6.3V/EC/SMT

19 3 C141,C224,C239 33P

20 1 C144 27P

21 2 C201,C416 2P

22 9 C204,C501,C505,C507,C508, 470P

C509,C510,C602,C605

23 6 C207,C208,C409,C410,C431, 10U/16V T

C603

24 8 C211,C405,C609,C611,C612, 1U/Y5V 0805

C613,C614,C615
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0803VRI2.SCH Revised: February 27, 2014

136~165MHZ/12.5KHZ Revision:

Bill Of Materials February 27, 2014 10:21:12

Item Quantity Reference Part

________________________________________________________________

25 1 C213 18P

26 1 C219 3P

27 4 C232,C238,C240,C417 15P

28 2 C243,C245 12P

29 2 C304,C305 6P

30 3 C306,C309,C315 1P

31 2 C327,C425 2.2U/10V T

32 1 C335 8P

33 2 C413,C604 104P/X7R

34 1 C414 1U/16V T

35 1 C430 47U/16V/EC/SMT

36 1 C432 33U/6.3V EC

37 2 C503,C504 22P

38 1 C512 100U/16V/EC/SMT

39 1 CD1 CDS455C24

40 1 CF1 CFU455HT/3PIN

41 1 D101 1SS362
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0803VRI2.SCH Revised: February 27, 2014

136~165MHZ/12.5KHZ Revision:

Bill Of Materials February 27, 2014 10:21:12

Item Quantity Reference Part

________________________________________________________________

42 1 D102 1SS355

43 3 D201,D207,D501 RLS4148

44 2 D202,D203 1SS314

45 1 D204 PTZ5.6B

46 2 D205,D206 HVU131

47 3 D301,D302,D303 1SV215

48 2 D401,D601 RLZ3.0B

49 1 D502 RLZ4.3B

50 1 D503 1N4004 SMT

51 1 J201 BNC

52 1 J501 CONNECTOR DB9

53 7 L101,L102,L103,L104,L105, 27NH

L106,L107

54 2 L201,L308 150NH

55 1 L202 56NH

56 1 L203 22NH

57 2 L204,L401 1UH

58 1 L205 33NH
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0803VRI2.SCH Revised: February 27, 2014

136~165MHZ/12.5KHZ Revision:

Bill Of Materials February 27, 2014 10:21:12

Item Quantity Reference Part

________________________________________________________________

59 2 L206,L212 0.45*2.3*7T

60 1 L207 0.45*1.5*5T

61 1 L208 0.45*1.5*6T

62 1 L209 2.2UH/1008

63 1 L210 0.45*2.3*8T

64 1 L211 0.45*2.3*6T

65 4 L301,L303,L304,L307 2.2UH

66 1 L302 68NH

67 1 L305 39NH

68 1 L306 0.82UH

69 1 L601 125MH

70 1 Q101 2SC5086

71 1 Q102 3SK318

72 1 Q103 2SC4215

73 1 Q104 DTC144EE

74 1 Q105 DTA144EE

75 4 Q201,Q205,Q305,Q405 2SC4083
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0803VRI2.SCH Revised: February 27, 2014

136~165MHZ/12.5KHZ Revision:

Bill Of Materials February 27, 2014 10:21:12

Item Quantity Reference Part

________________________________________________________________

76 7 Q202,Q203,Q306,Q402,Q404, 2SC4116

Q408,Q409

77 1 Q204 DTA123YE

78 1 Q206 BFG35

79 1 Q207 2SK3476

80 2 Q301,Q302 MMBFJ310LT1

81 1 Q303 UMG2N

82 3 Q401,Q403,Q501 2SA1586

83 2 Q406,Q407 BCW68G

84 1 Q502 UMH6N

85 1 R101 8.2K

86 3 R102,R112,R204 3K3

87 1 R104 180R

88 6 R105,R106,R107,R213,R304, 330R

R307

89 2 R108,R227 470K

90 9 R109,R114,R202,R310,R420, 4.7K

R422,R424,R425,R501

91 1 R110 5.6K
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0803VRI2.SCH Revised: February 27, 2014

136~165MHZ/12.5KHZ Revision:

Bill Of Materials February 27, 2014 10:21:12

Item Quantity Reference Part

________________________________________________________________

92 14 R111,R201,R209,R210,R225, 10K

R302,R305,R407,R410,R411,

R508,R610,R612,R621

93 1 R113 15K

94 4 R115,R220,R415,R608 2.7K

95 1 R116 510K

96 5 R117,R226,R412,R413,R602 100R

97 1 R118 180K

98 1 R119 150K

99 9 R120,R121,R404,R405,R503, 100K

R607,R611,R613,R617

100 1 R203 220R

101 11 R205,R207,R208,R419,R421, 1K

R423,R502,R506,R507,R604,

R609

102 2 R206,R601 27K

103 1 R211 560R

104 2 R212,R603 2.2K

105 1 R214 10R

106 3 R215,R217,R605 820R
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0803VRI2.SCH Revised: February 27, 2014

136~165MHZ/12.5KHZ Revision:

Bill Of Materials February 27, 2014 10:21:12

Item Quantity Reference Part

________________________________________________________________

107 1 R216 5.6R

108 4 R218,R308,R504,R505 470R

109 2 R219,R223 56R

110 1 R222 22R/0805

111 3 R224,R408,R409 22K

112 2 R301,R303 47R

113 1 R309 120K

114 1 R401 150R

115 9 R402,R403,R606,R614,R615, 47K

R616,R618,R619,R620

116 1 R406 33K

117 2 R414,R417 1.2K

118 1 R416 7.5K

119 1 R418 91K

120 1 R509 1M

121 1 R622 680R

122 1 RP501 10K*4 SMT

123 1 S501 DIGITAL SW 16CH SMT
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0803VRI2.SCH Revised: February 27, 2014

136~165MHZ/12.5KHZ Revision:

Bill Of Materials February 27, 2014 10:21:12

Item Quantity Reference Part

________________________________________________________________

124 1 T101 P1007X

125 1 U101 AA32416A

126 1 U401 MB1504 SMT

127 1 U402 UTC7805 SMT

128 1 U501 ELM7S32

129 1 U502 PIC16C57/XT SMT

130 1 U503 93C46 SMT

131 1 U601 LM386D

132 1 U602 TL064CD SMT

133 1 VC201 30PVC

134 1 VR101 10KB/SMT

135 1 VR401 100KB SMT

136 2 VR601,VR602 10KB SMT

137 1 X101 20.945MHZ UM1

138 1 X401 12.8MHZ TCXO/SMT

139 1 X501 3.58MHZ 3X9

140 1 XF101 21M08B
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8.PROGRAMMER INSTRUCTION

Welcome to PC Programmer.

Please Read this file, before you first use the software.

TABLE OF CONTENTS

1. Brief introduction

2. Before Installing

3. Install PC Programmer

4. INSTRUCTIONS

5. UnInstall PC Programmer

1. Brief introduction

Welcome to PC Programmer. This program is designed to be used with the

Interface Adapter.

The following equipment will be needed to program the Device:

A. A computer to install this program with at least 2 MB available space

in hard disk and a 9-pin male RS-232 serial port.

B. Win XP Operation System.

C. Part of the Programming Kit

1) An interface Adapter.

2) A CD disk with the program, PC Programmer files

2. Before Installing

Before You Run Setup, make sure that your computer meets the minimum

requirements mentioned above, and read the Readme file(this file).

NOTE: If you firstly install PC Programmer in you system, the setup may

update some system files on your computer , so you may run the

setup again after your system be updated. Please follow the

installation instruction on the screen.

3. Install

TO install PC Programmer on your computer

1)Insert the CD.

2)Run Setup.exe

3)Follow the installation instruction on the screen.

Important: You cannot simply copy files from the CD to your hard disk

and run PC Programmer . You must use the Setup program,

which decompresses and installs the files in the appropriate

directories. PAGE 23



4. INSTRUCTIONS

4.1 Connection

4.2 Start up PC Programmer

4.3 Edit Configuration

4.3.1 Open/Recall/Upload Configuration file

4.3.2 Edit Channel data

4.3.3 Set Option item

4.3.4 (Block)Cut/Copy/Delete/Paste

4.3.5 Auto-Frequency edit

4.3.6 Save a Configuration to disk

4.3.7 Download Configuration to device

4.3.8 Print a Configuration

4.4 Exit PC Programmer

4.1 Connection

1.Connect one side of Interface Adapter to the computer's serial port.

Never care the port number, the PC Programmer will locate it

automatically.

2.Connect the other side of Interface Adapter to the Device's 26-pin

female port.

3.Connect power supply to device and LED will be light. The device will into

PC_programming mode automatically, please see the picture of below.
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4.2 Start up PC Programmer

1.Select 'Start', choose 'Programs',

click on the '*** AES-7350 Series' program.

2.When HD Serial PC Programmer is started, a main form will be shown

after a greeting form.

3.There has a menu bar at the top of the main form, and a message box

at the bottom.

PAGE25



NOTE:The program is menu driven for all pertinent commands. All the

commands can be accessed by either key board or the left mouse

button.

Access keys mainly used are:

'Tab' or 'Arrow' to move focus(or cursor)

'Enter' to active a focused command

4.3 Edit Configuration

4.3.1 Open/Upload Configuration file

To edit the configuration, please either

1)Recall an Existing Configuration by click on the 'Open' item in

the File Menu, select the configuration file by click on or input

its name then press 'Enter' key.

OR 2)Upload configuration data from a device by click on 'Upload' item

in the Device menu. to a Configuration window .

Different Model's device Configuration can be opened and edited.

There are two fields in each Configuration window: system data

and Channel data.

OR 3)Open an existing Configuration by click on the 'OPEN' item in the

File Menu. A pop up window will be shown, select a file by arrow

key or mouse then click 'OK'.

4.3.2 Edit Channel data

1)Set focus to the Channel data field by move the mouse pointer.

2)Select a particular channel number to be edited by either the

arrow key or click on it.

3)Pop up input window by either press 'Enter' key or double click

on the selected channel number.

4)Use computer's cursor keys, Tab key, Enter key, arrow key or

mouse to renew the channel data.

5)Click 'OK' button on the input window to accept the change or

'Cancel' to not change, and return back to Configuration Window.

4.3.3 Edit Option item

1)To Edit Channel Option, Select a particular channel number in

the Option View Window by either the arrow key or click on it,

then Pop up the input window for Channel Option, 'Enter' key or

double click on the selected channel number.

PAGE26



2)To Edit System Option, Pop up input window for System Option,

click "SYSTEM" in the 'OPTION' menu.

3)To Edit Advanced Option, Pop up input window for Advanced Option,

click "ADVANCED OPTION" in the 'OPTION' menu.

4Use computer's cursor keys, Tab key, Enter key, arrow key or

mouse to renew the Option Item.

5)Click 'OK' button on the input window to accept the change or

'CANCEL' to not change, and return back to Configuration Window.

4.3.4 (Block)Cut/Copy/Delete/Paste

To select a block of channel data as source by either

1)Select start channel by arrow key, then while press 'Shift' key

select end channel number by arrow key.

2)Click on start channel, then while press 'Shift' key click on

end channel number

3)Press the left mouse button on start channel then move the mouse

until reach the end channel number, release left mouse button.

A)To Cut selected (block) Channel(s) either press 'Ctrl'+'X'or

click 'CUT' item in Edit menu.

B)To Copy selected (block) Channel(s) either press 'Ctrl'+'C'or

click 'COPY' item in Edit menu.

C)To Delete selected (block) Channel(s) either press 'Del(Delete)'

key or click on 'DELETE' item in Edit menu.

After Cut or Copy, the data can be pasted to where you want.

D)To Paste , select a channel as the start number of target , then

either press 'Ctrl'+'V' or click on 'PASTE' item in Edit menu.

NOTE: Paste operation allows you to export data to any Configuration

window opened.

4.3.5 Auto-Frequency edit

This feature provide you with a quick Frequency set function.

To use this command after either

1)Click 'EDIT' Menu

2)Click on 'AUTOFREQ' item in 'EDIT' menu to pop up a input window.

3)Use computer's cursor keys, Tab key, Enter key, arrow key or mouse

to set data.

4)Click 'OK' button on the input window to accept the change or

'CANCEL' to not change, and return back to Configuration Window.
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4.3.6 Save a Configuration to disk

1)Different configuration can be saved to disk.

2)Click on 'SAVE' item in 'FILE' Menu will overwrite an existing

configuration file on your disk by current configuration.

3)Select 'SAVE AS' from 'FILE' Menu will save the current

configuration by a name as you prefer.

4.3.7 Download to device

To Download current Configuration to device, select 'DOWNLOAD' from

sub menu under 'DEVICE' menu.

4.3.8 Print a Configuration

Click on 'PRINT' item in 'FILE' Menu will send current Configuration

to printer.

4.4 Exit PC Programmer

To Exit PC Programmer,click on 'EXIT' item in 'FILE' Menu.

5. UnInstall PC Programmer

To uninstall PC Programmer from your hard disk, select 'Start'

, choose 'Settings', click on the 'Control Panel', then find 'Add/Remove

Programs' icon from the pop up window then double click on it, then find

'*** Serial PC Programmer' from application list and click on it, then click

on 'Add/Remove' button under application list, then follow the

instructions on your screen.
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Federal Communication Commission Interference Statement

This equipment has been tested and found to comply with the limits for a Class B 
digital device, pursuant to Part 90 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference in a residential 
installation.

This equipment generates, uses and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful interference 
to radio communications. However, there is no guarantee that interference will not 
occur in a particular installation. If this equipment does cause harmful interference to 
radio or television reception, which can be determined by turning the equipment off 
and on, the user is encouraged to try to correct the interference by one of the 
following measures:
. Reorient or relocate the receiving antenna.
. Increase the separation between the equipment and receiver.
. Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected.
. Consult the dealer or an experienced radio/TV technician for help.

FCC Caution: To assure continued compliance, any changes or modifications not
expressly approved by the party responsible for compliance could void the user's
authority to operate this equipment. (Example - use only shielded interface cables
when connecting to computer or peripheral devices).

FCC Radiation Exposure Statement

This equipment complies with FCC RF radiation exposure limits set forth for an 
uncontrolled environment. This equipment should be installed and operated with a 
minimum distance of 0.9 m between the radiator and your body.

This transmitter must not be co-located or operating in conjunction with any other
antenna or transmitter.

The antennas used for this transmitter must be installed to provide a separation 
distance of at least 0.9 m from all persons and must not be co-located or operating in 
conjunction with any other antenna or transmitter.

This device complies with Part 90 of the FCC Rules. Operation is subject to the 
following two conditions:
(1) This device may not cause harmful interference, and (2) This device must accept 
any interference received, including interference that may cause undesired operation.




